Attention Windows Users!
After this manual was written, QUALCOMM simplified the installation process for you. Instead of reading the Windows chapter in this manual, see the Quick Start guide in your kit.
This guide is based on the production version of the QUALCOMM Globalstar GSP-1600 Tri-Mode Phone. Software changes may have occurred after this printing.

QUALCOMM reserves the right to make changes in technical and product specifications without prior notice.
Cautions and Warnings

Caution
Avoid exposing the phone and accessories to rain or other liquids. If the phone gets wet, turn the power off immediately and remove the battery pack.

Note
When using a QUALCOMM Globalstar Tri-Mode Phone for Globalstar packet data, observe the same safety guidelines that apply when making voice calls. For complete details, see the “Cautions and Warnings” and “Safety Information” sections of the QUALCOMM Globalstar GSP-1600 Tri-Mode Phone User Guide (document number 80-98153-1).
Getting Started ........................................................................................................1
  What Is QUALCOMM Globalstar Packet Data Service? ........................................1
  What Does Globalstar Packet Data Service Let Me Do? .....................................1
  How Does It Work? ................................................................................................1
  What Do I Need to Use Globalstar Packet Data? .................................................2
  Using Your Tri-Mode Phone ................................................................................2
  Using Your Computer ..........................................................................................3
  Using Cables and Accessories ..........................................................................4
  Working with Your Service Provider ...................................................................4

Windows Computers ...............................................................................................5
  Connecting Windows Components ......................................................................5
  Configuring Your Windows PC .........................................................................7
  Instructions for Windows 95, 98, and NT .........................................................8
    Setting Up a New Modem Driver (95, 98, NT) ............................................8
    Setting Up Dial-Up Networking (95, 98, NT) ............................................15
  Instructions for Windows 2000 .......................................................................24
    Setting Up a New Modem Driver (Windows 2000) ....................................24
    Setting Up a New Connection (Windows 2000) ........................................30
  Making a Globalstar Packet Data Connection ...............................................40
  Using Typical Communication Applications ..................................................41

Macintosh Computers ............................................................................................43
  Connecting Macintosh Components ...............................................................43
  Configuring Your Macintosh ............................................................................46
    Copying the Modem Script File to Your Macintosh ..................................46
    Configuring Remote Access ......................................................................46
  Making a Globalstar Packet Data Connection ...............................................53
  Using Typical Communication Applications ..................................................54

Palm Handhelds .....................................................................................................55
  Connecting Palm Components ..........................................................................55
  Configuring Your Palm Handheld ......................................................................57
    Setting Up a Modem ....................................................................................57
    Setting Up Your Network Connection .......................................................59
  Making a Globalstar Packet Data Connection ...............................................61
  Using Palm Communication Applications ......................................................63

UNIX Computers ..................................................................................................65
  Connecting UNIX Components ..........................................................................65
  Configuring Your Solaris UNIX Computer ......................................................67
    Setting Up the PPP Client ............................................................................67
    Checking the GS Packet Data Setup ..........................................................69
    Making a Globalstar Packet Data Connection ............................................69
  Configuring Your Linux Computer ..................................................................70
    Setting Up the Modem and PPP Connection ..............................................70
    Configuring the PPP Connection ................................................................72
    Configuring the Name Server ....................................................................75
    Saving Your Settings ....................................................................................76
    Making a Globalstar Packet Data Connection ............................................77
Getting Started

What Is QUALCOMM Globalstar Packet Data Service?

QUALCOMM Globalstar packet data service lets you access the Internet or other TCP/IP packet-switched networks through your QUALCOMM Globalstar GSP-1600 Tri-Mode Phone.

For a packet data connection, your QUALCOMM Globalstar Tri-Mode Phone serves as a wireless modem. It connects a computer, such as a laptop or Palm handheld, to the Internet via the Globalstar Satellite Communications System.

What Does Globalstar Packet Data Service Let Me Do?

Once you have connected, you can use familiar software applications such as Eudora, Netscape Navigator, or Microsoft Internet Explorer for anything you would normally do through your network provider or Internet Service Provider (ISP). For example, you could

- Browse the Internet
- Access e-mail
- Transmit information
- Use telnet (for example to connect with host applications at work)
- Transfer files using FTP (File Transfer Protocol)

And you can do all of these from virtually any location, at over-the-air data rates of up to 9600 bits per second, with no additional modem or dedicated telephone circuits required.

How Does It Work?

Here’s a quick overview of how Globalstar packet data service works.

Cable

- Connect your QUALCOMM Globalstar Tri-Mode Phone to the computer or Palm handheld, using a QUALCOMM serial data cable and any optional accessories.

Configure

- Configure your computer or Palm handheld organizer to use Globalstar packet data service (you need to do this only once).

Connect

- Click a GS Packet Data connection icon or menu on your computer.
- The QUALCOMM Globalstar Tri-Mode Phone establishes a packet data connection to the Globalstar Satellite Communications System, using Point-to-Point Protocol (PPP).
Cruise

- Open the application you want to use, for example an Internet browser where you type in a Web address.
- Your computer or Palm handheld sends data packets to the Tri-Mode Phone.
- The Tri-Mode Phone transmits data packets to a satellite and Gateway in the Globalstar Satellite Communications System.
- Packets are routed to and from your network service provider through the Globalstar Satellite System.
- A router in the Globalstar Gateway connects to the Internet.

What Do I Need to Use Globalstar Packet Data?

To use Globalstar packet data service, you need:

- A QUALCOMM Globalstar GSP-1600 Tri-Mode Phone
- A computer or Palm handheld capable of Internet access using PPP
- QUALCOMM serial data cable (included, along with this manual, in the QUALCOMM Globalstar Packet Data Kit: For the Tri-Mode Portable Satellite Phone)
- Optional cables or accessories as needed, to connect the QUALCOMM data cable to your computer (using a TIA/EIA-574 DTE serial interface)

Using Your Tri-Mode Phone

For packet data connections, your QUALCOMM Globalstar GSP-1600 Tri-Mode Phone works much as it would for a voice call. Here are some general tips for using your Tri-Mode Phone for packet data:

- Make sure the Tri-Mode Phone battery is charged and properly installed.
- Position the Tri-Mode Phone outdoors where its Globalstar Satellite Antenna has an unimpeded view of the sky (or mount it in a vehicle using a QUALCOMM Globalstar Hands-Free Car Kit).
■ Make sure that tall obstacles, such as buildings and trees, do not block sky (satellite) access.
■ Extend the Globalstar Satellite Antenna to point straight up to the sky.
■ Lay the Tri-Mode Phone on its side on a convenient surface such as a table for hands-free operation.
■ Never hold the Tri-Mode Phone by the Globalstar Satellite Antenna.
■ Remember, the Tri-Mode Phone will not work inside a building, nor will it work in a vehicle unless you are using a car kit.

Note
For complete details about how to use your QUALCOMM Globalstar Tri-Mode Phone, see the QUALCOMM Globalstar GSP-1600 Tri-Mode Phone User Guide (document number 80-98153-1).

Using Your Computer

Compatible Computer Systems
You can use Globalstar packet data service with the following computers and operating systems (OS):

■ IBM-compatible PCs
  □ Microsoft Windows 95, 98, NT 4.0, 2000
  □ One available serial port (for connecting the Tri-Mode Phone)
  □ For setup instructions, see “Windows Computers” on page 5

■ Apple Macintosh computers
  □ Mac OS 7.6 or higher
  □ For setup instructions, see “Macintosh Computers” on page 43

■ Palm handheld organizers
  □ Palm OS
  □ Palm handheld organizer with a serial port
  □ For setup instructions, see “Palm Handhelds” on page 55

■ UNIX Computers
  □ Red Hat Linux
  □ Solaris UNIX
  □ For setup instructions, see “UNIX Computers” on page 65

Where to Position Your Computer
You have several options for positioning a computer to use Globalstar packet data service:

■ Take a portable computer (laptop or Palm handheld) outdoors and connect it near the Tri-Mode Phone, for example on a picnic table.
■ Connect an optional extension cable (see “Commercially Available Accessories” on page 81) between a computer inside a building and the Tri-Mode Phone outdoors.
■ In a vehicle, use a QUALCOMM Globalstar Hands-Free Car Kit (and serial cable) to connect a computer to a Tri-Mode Phone.
Using Cables and Accessories

Cables or accessories connect your QUALCOMM Globalstar Tri-Mode Phone to your computer. They vary depending on the computer type:

<table>
<thead>
<tr>
<th>Computer</th>
<th>Cables and accessories needed</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM-compatible PC (Windows)</td>
<td>• QUALCOMM serial data cable (included in the QUALCOMM Globalstar Packet Data Kit)</td>
</tr>
<tr>
<td></td>
<td>• optional USB-to-serial adapter, if your PC uses USB (Universal Serial Bus) connectors</td>
</tr>
<tr>
<td></td>
<td>• optional extension cable, if desired</td>
</tr>
<tr>
<td>Apple Macintosh</td>
<td>• QUALCOMM serial data cable (included in kit)</td>
</tr>
<tr>
<td></td>
<td>• Macintosh modem cable</td>
</tr>
<tr>
<td></td>
<td>• adapter (female 25-pin to male 9-pin)</td>
</tr>
<tr>
<td></td>
<td>• optional USB-to-serial adapter, if your Mac uses USB (Universal Serial Bus) connectors</td>
</tr>
<tr>
<td></td>
<td>• optional extension cable, if desired</td>
</tr>
<tr>
<td>Palm handheld</td>
<td>• QUALCOMM serial data cable (included in kit)</td>
</tr>
<tr>
<td></td>
<td>• Palm HotSync cable (or appropriate Palm cable)</td>
</tr>
<tr>
<td></td>
<td>• null modem adapter, male 9-pin on both ends</td>
</tr>
<tr>
<td></td>
<td>• optional extension cable, if desired</td>
</tr>
<tr>
<td>Red Hat Linux, Solaris UNIX</td>
<td>• QUALCOMM serial data cable (included in kit)</td>
</tr>
<tr>
<td></td>
<td>• optional extension cable, if desired</td>
</tr>
<tr>
<td>QUALCOMM Globalstar Hands-Free</td>
<td>• serial cable with a male 9-pin connector on one end and a female 9-pin connector on the other</td>
</tr>
<tr>
<td>Car Kit</td>
<td>• other cables or adapters as listed above for your specific computer (for setup instructions, see “QUALCOMM Globalstar Hands-Free Car Kit” on page 79)</td>
</tr>
</tbody>
</table>

Note

For more information about optional accessories, see “Commercially Available Accessories” on page 81.

Working with Your Service Provider

When you use Globalstar packet data service, your network provider or Internet Service Provider (ISP) supplies your Internet service through the Globalstar Gateway.

Check with your service provider for details about their service features.
Windows Computers

This chapter tells how to configure a computer running Windows 95, 98, NT, or 2000 to use Globalstar packet data service. To do this, you physically connect the computer to your QUALCOMM Globalstar Tri-Mode Phone, then configure a “modem” driver and a new dial-up networking connection.

Attention Windows users! After this manual was written, QUALCOMM simplified the installation for Windows. Instead of using the procedures in this chapter, see the Quick Start guide in your kit.

Note
Physically connecting hardware components is similar for all Windows versions. However, modem/networking configuration differs significantly for Windows 2000. See “Instructions for Windows 95, 98, and NT” on page 8 or “Instructions for Windows 2000” on page 24, as appropriate.

Connecting Windows Components

To use Globalstar packet data service with Windows, you connect the following hardware components:

- A PC or laptop running Microsoft Windows
- QUALCOMM serial data cable (included in the QUALCOMM Globalstar Packet Data Kit)
- QUALCOMM Globalstar GSP-1600 Tri-Mode Phone
To connect a Windows PC to the Tri-Mode Phone

1. Turn off the power on your QUALCOMM Globalstar Tri-Mode Phone. You can leave your computer turned on.

2. Attach the QUALCOMM data cable’s 9-pin serial connector to a serial COM port (RS-232) on your PC, then manually tighten the screws to hold it in place.

3. Holding the other end of the QUALCOMM data cable, press both buttons on the side of the connector, then insert it into your Tri-Mode Phone with the arrow facing up (toward the phone’s keypad). The connector should snap into place for a secure fit.

4. Turn on your Tri-Mode Phone.

5. Extend the Globalstar Satellite Antenna to a 90° position.

Note
If you cannot obtain a signal with the Globalstar Satellite Antenna in a 90° position, try rotating it further until you feel it click into place.
Configuring Your Windows PC

To configure a Windows PC to use Globalstar packet data service, you do the following:

■ Set up a modem driver so your QUALCOMM Globalstar Tri-Mode Phone can act as a wireless modem.
■ Configure Windows to access the Internet via Globalstar packet data service using Point-to-Point Protocol (PPP).

Attention Windows users! After this manual was written, QUALCOMM simplified the installation for Windows. Instead of using the procedures in this chapter, see the Quick Start guide in your kit.

Note
To configure a Windows NT or Windows 2000 PC to use Globalstar packet data service, you must have "Admin" rights for that computer.

Caution
For configuring your Windows PC, the procedures and screens vary depending on which version of Windows you have. Be sure to use the correct instructions for your Windows version.

❑ Windows 95, 98, and NT — Go to "Instructions for Windows 95, 98, and NT" on page 8.
Instructions for Windows 95, 98, and NT

This section applies to Windows 95, 98, and NT. The sample screens use Windows 98, but only minor differences exist between versions.

Note
If you are using Windows 2000, go to “Instructions for Windows 2000” on page 24.

Setting Up a New Modem Driver (95, 98, NT)

1. Go to the Windows Control Panel, then double-click Modems.
2. In the Modem Properties dialog, click Add to add your new “modem.”

The Install New Modem wizard appears. Follow the procedures below to enter appropriate information in the wizard dialogs.

Selecting the Type of Modem

1. In the Install new Modem dialog, select “Other.”
2. Click Next.
Telling Windows Not to Auto-Detect the Modem

1. Select “Don’t detect my modem; I will select it from a list.”
   Since your QUALCOMM Globalstar Tri-Mode Phone acts as a wireless modem, there is no physical modem to detect.

2. Click Next.
Selecting a Standard Modem

1. From the “Manufacturers:” list, select “(Standard Modem Types).”
2. From the “Models” list, select “Standard 33600 bps Modem.”
   or
   If you are using Windows NT, select “Standard 19200 bps Modem.” (Windows NT does not include modem drivers for speeds above 28800.)
3. Click Next.

Selecting the COM Port

1. Select the Communications (COM) Port to which you have connected the QUALCOMM data cable. This must be an RS-232-capable serial COM port (COM1 is the standard).

   Caution
   Windows NT allows only one modem to be assigned to a given COM port. If you connect your Globalstar phone on a port where a modem has already been installed, Windows NT deletes the setting for the previous modem.

2. Click Next.
3. When the wizard says, “Your modem has been set up successfully,” click Finish to complete the modem installation.

Setting Modem Properties

1. In the Modems Properties dialog, on the General tab, select the modem you previously selected (“Standard 33600 bps Modem” or “Standard 19200 bps Modem”).

2. Click Properties.
Setting the Maximum Speed

1. In the Standard [33600 or 19200 bps] Modem Properties dialog, make sure the COM port is correct for your QUALCOMM data cable connection.
2. Set “Maximum Speed” to 38400 bps.

   The maximum speed for the modem must match the baud rate on your Tri-Mode Phone (38400 bps is the phone’s default). If the speeds are not the same, the computer cannot communicate with the Tri-Mode Phone.

   **Tip**
   You can check or change the baud rate on your Tri-Mode Phone by selecting menu, then selecting Features > Data > Baud Rate. If the baud rate on your Tri-Mode Phone is not set to 38400 bps, be sure to change the modem’s maximum speed so that the two speeds match.

   **Note**
   38400 bps is the speed at which the Tri-Mode Phone communicates with your computer, not the speed at which it communicates with the Gateway.

3. Click the Connection tab.

![Modem Properties dialog box](image)
Configuring the Connection

1. In the **Standard [33600 or 19200 bps] Modem Properties** dialog, click the **Connection** tab.
2. Set “Data Bits” to “8.”
3. Set “Parity” to “None.”
4. Set “Stop Bits” to “1.”
5. Click **Advanced**.

Configuring Flow Control and Hardware Settings

1. In the **Advanced Connection Settings** dialog, select “Use flow control.”
2. Select “Hardware (RTS/CTS).”
3. Click **OK**.
Closing the Connection Tab
1. In the Standard [33600 or 19200 bps] Modem Properties dialog, click OK.

Completing Modem Setup
1. In the Modem Properties dialog, click Close to complete your modem setup.

You have finished setting up the modem driver for Windows 95, 98, or NT. Now you must set up Dial-Up Networking.
Setting Up Dial-Up Networking (95, 98, NT)
This section applies to Windows 95, 98, and NT. For Windows 2000, do not use the procedures in this section. Instead, go to “Setting Up a New Connection (Windows 2000)” on page 30.

Making a New Connection
1. On your Windows desktop, double-click My Computer.
2. In the My Computer window, double-click Dial-Up Networking.
3. If a Dial-Up Networking window containing a Make New Connection icon appears, Dial-Up Networking is already installed on your computer; go to Step 4.

   If a Dial-Up Networking wizard containing an Install button appears, Dial-Up Networking is not installed. Click Install, then follow the wizard dialogs to install it. You may need your Windows installation disks. When installation is complete, go to Step 4.

4. In the Dial-Up Networking window, double-click the Make New Connection icon.
   or

   If you are using Windows NT, double-click New.
Configuring the New Connection

1. In the Make New Connection dialog, in the “Type a name for the computer you are dialing” field, type a name for your connection (for example, “GS Packet Data”).

   Note
   On Windows NT, the Make New Connection dialog is called New Phonebook Entry.

2. In the “Select a device” drop-down list, select the modem you previously installed (“Standard 33600 bps Modem” or “Standard 19200 bps Modem”).

3. Click Configure.
Configuring Modem Properties

1. In the Standard [33600 or 19200 bps] Modem Properties dialog, on the General tab, make sure the port and maximum speed (38400 bps) match what you set for the modem (under “Setting the Maximum Speed” on page 12).

![Standard 33600 bps Modem Properties dialog]

Note: On Windows NT, “Maximum speed” is called “Initial speed.”

2. On the Connection tab, make sure the “Connection preferences” are set to “8,” “None,” “1.”

3. Click Advanced.
4. In the **Advanced Connection Settings** dialog, make sure “Use flow control” and “Hardware (RTS/CTS)” are selected.

5. On the **Options** tab, make sure that none of the check boxes under “Connection Control” are selected.


7. Click **OK** to return to the **Make New Connection** dialog.
Making a New Connection

1. In the Make New Connection dialog, click Next.
2. Do not type anything in the “Area code:” field. Make sure it is empty.
3. In the “Telephone number:” field, type “#777.”
   “#777” is a special number that tells the Tri-Mode Phone to make a packet data connection.
4. In the “Country Code” field, select any country (for example, your home country).
5. Click Next.
6. To create your connection, click **Finish**.

Your packet data connection (for instance, “GS Packet Data”) should now appear in the **Dial-Up Networking** window. You can drag your connection icon to the desktop to create a shortcut, if you prefer.

**Setting Connection Properties**

1. In the **Dial-Up Networking** window (or on your desktop), right-click the packet data connection icon that you have created (for instance, “GS Packet Data”) and select **Properties**.

or

If you are using Windows NT, under “Phone entry to dial,” select the connection you created, click **More**, then select “Edit entry and modem properties...”
2. In the GS Packet Data dialog, click the Server Types tab.
   or
   If you are using Windows NT, click the Server tab.
3. Under “Type of Dial-Up Server,” select “PPP.”
5. Under “Allowed network protocols,” select “TCP/IP.”
6. Click TCP/IP Settings.
Configuring TCP/IP Settings

1. In the TCP/IP Settings dialog, select “Server assigned IP address.”
2. Select “Specify name server addresses,” then enter the primary and secondary DNS addresses assigned by your Service Provider or ISP.

Note

DNS address numbers in the illustration are examples only. Ask your Service Provider or ISP for the numbers you should enter.

3. Select “Use IP Header Compression.”
4. Select “Use default gateway on remote network.”
5. Click OK.

6. In the GS Packet Data dialog, click OK.

Setting Dial Properties

1. Double-click your packet data connection icon.
   or
   If you are using Windows NT, make sure “Phone number preview” reads “#777.” At this point, for Windows NT, you have finished setting up Dial-Up Networking. To make a Globalstar connection, skip ahead to “Making a Globalstar Packet Data Connection” on page 40.

2. In the Connect To dialog, check the “Phone number” field to make sure that the “#” character appears in front of the “777.” If it does not, you must add it to the next dialog, in Step 6.

   Some versions of Windows may not retain the “#” as part of the telephone number, even though you entered it under “Making a New Connection” on page 15.
3. Click Dial Properties.

4. In the Dialing Properties dialog, make sure you select the same country that you selected earlier, under “Making a New Connection” on page 19.


6. If the “#” character did not appear in front of the “777” in Step 2., then in the “For local calls, dial” field, type #.

7. Click OK.

You have finished setting up Dial-Up Networking for Windows 95 or 98. To make a Globalstar connection, skip ahead to “Making a Globalstar Packet Data Connection” on page 40.
Instructions for Windows 2000

This section applies only to Windows 2000.

Note
If you are using another version of Windows, do not use the procedures in this section. Instead, go to “Instructions for Windows 95, 98, and NT” on page 8.

Setting Up a New Modem Driver (Windows 2000)
1. Go to the Windows Control Panel, then double-click Phone and Modem Options.
2. In the Phone and Modem Options dialog, click the Modems tab.
3. Click Add.

The Add/Remove Hardware Wizard appears. Follow the procedures below to enter appropriate information in the wizard dialogs.
Telling Windows Not to Auto-Detect the Modem

1. Select “Don’t detect my modem; I will select it from a list.”
   Since your QUALCOMM Globalstar Tri-Mode Phone acts as a wireless modem, there is no physical modem to detect.

2. Click Next.

Selecting a Standard Modem

1. From the “Manufacturers:” list, select “(Standard Modem Types).”

2. From the “Models:” list, select “Standard 19200 bps Modem.”
   Later (under “Setting the Maximum Speed” on page 27) you will change the modem’s maximum speed to 38400 bps, to match the baud rate on the Tri-Mode Phone.

3. Click Next.
Selecting the COM Port

1. Select the Communications (COM) Port to which you have connected the QUALCOMM data cable. This must be an RS-232-capable serial COM port (COM1 is the standard).

2. Click Next.

3. When the wizard says, “Your modem has been set up successfully,” click Finish to complete the modem installation.

Setting Modem Properties

1. In the Phone and Modem Options dialog, on the Modems tab, select “Standard 19200 bps Modem.”

2. Click Properties.
Setting the Maximum Speed

1. In the Standard 19200 bps Modem Properties dialog, make sure the COM port is correct for your QUALCOMM data cable connection.

2. Set “Maximum Port Speed” to 38400 bps.
   The maximum speed for the modem must match the baud rate on your Tri-Mode Phone (38400 bps is the phone’s default). If the speeds are not the same, the computer cannot communicate with the Tri-Mode Phone.

   Tip
   You can check or change the baud rate on your Tri-Mode Phone by selecting menu, then selecting Features > Data > Baud Rate. If the baud rate on your Tri-Mode Phone is not set to 38400 bps, be sure to change the modem’s maximum speed so that the two speeds match.

   Note
   38400 bps is the speed at which the Tri-Mode Phone communicates with your computer, not the speed at which it communicates with the Gateway.

3. In the Standard 19200 bps Modem Properties dialog, click the Advanced tab.
4. In the **Standard 19200 bps Modem Properties** dialog, on the **Advanced** tab, click **Change Default Preferences**.

   ![Change Default Preferences](image)

**Configuring the Connection**

1. In the **Standard 19200 bps Modem Default Preferences** dialog, make sure “Flow Control” is set to “Hardware.”

2. In the **Standard 19200 bps Modem Default Preferences** dialog, click the **Advanced** tab.
3. Set “Data Bits” to “8.”
4. Set “Parity” to “None.”
5. Set “Stop Bits” to “1.”
6. Click **OK**.

**Completing the Modem Setup**
1. In the **Standard 19200 bps Modem Properties** dialog, click **OK**.
2. In the **Phone and Modem Options** dialog, click **OK**.

![Phone and Modem Options dialog](image)

You have finished setting up the modem driver for Windows 2000. Now you must set up a new connection.

**Setting Up a New Connection (Windows 2000)**

The procedures in this section apply only to Windows 2000. Before you create a new connection in Windows 2000, you must set up the modem driver. See “Setting Up a New Modem Driver (Windows 2000)” on page 24.

**Opening Network and Dial-up Connections**

1. Go to the Windows Control Panel, then double-click **Network and Dial-Up Connections**.
Configuring the Connection

1. In the Network and Dial-Up Connections window, double-click the Make New Connection icon.
2. In the Network Connection Wizard dialog, click Next.
3. Select “Dial-up to the Internet.”
4. Click Next.
5. Select “I want to set up my Internet connection manually, or I want to connect through a local area network (LAN).”

6. Click **Next**.

7. Under “How do you connect to the Internet?” select “I connect through a phone line and a modem.”

8. Click **Next**.
Providing Account Information

1. Under “Internet account connection information,” make sure that the “Use area code and dialing rules” check box is not selected.

2. In the “Telephone number” field, type “#777.” “#777” is a special number that tells the Tri-Mode Phone to make a packet data connection.

3. Click Next.

4. On the account logon screen, leave the “User name” and “Password” fields blank.

5. Click Next.
A message box appears, asking if you want to continue with a blank user name.

6. Click **Yes**.

A similar message box appears, asking if you want to continue with a blank password.

7. Click **Yes**.

If you have a user name and password for connecting to your ISP, you will be prompted for these later when you make a Globalstar packet data connection.

**Naming Your Dial-Up Connection**

1. In the “Connection name” field, type a name for your dial-up connection (for example, “GS Packet Data”).

2. Click **Next**.
Completing the Configuration

1. On the “Set Up Your Internet Mail Account” screen, under “Do you want to set up an Internet account now?”, select No. An Internet mail account is not required for Globalstar Packet Data.

2. Click Next.

3. On the “Completing the Internet Connection Wizard” screen, make sure the check box for “To connect to the Internet immediately” is not selected.

4. Click Finish.
Configuring Networking Properties

1. In the Network and Dial-up Connections window, right-click the GS Packet Data icon (or the icon for whatever you have named your dial-up connection).
2. In the popup menu, select Properties.
3. On the GS Packet Data Properties dialog, click the Networking tab.
4. Select “Internet Protocol (TCP/IP).”
5. Click Properties.
Configuring TCP/IP Properties

1. On the Internet Protocol (TCP/IP) Properties dialog, make sure “Obtain an IP address automatically” is selected.
2. Click Advanced.

3. On the Advanced TCP/IP Settings dialog, click the DNS tab.
4. Under “DNS server addresses, in order of use,” click Add.
5. In the TCP/IP DNS Server dialog, in the “DNS server” field, enter the primary (or “preferred”) DNS address assigned by your Service Provider or ISP.

6. Click Add.

Note
DNS address numbers in the illustration are examples only. Ask your Service Provider or ISP for the numbers you should enter.

7. If you have a secondary (or “alternate”) DNS address, enter it by repeating Step 4., Step 5., and Step 6.

Completing Advanced TCP/IP Settings
1. On the Advanced TCP/IP Settings dialog, select “Append these DNS suffixes (in order).”
2. Under “Append these DNS suffixes (in order),” click Add.
3. In the TCP/IP Domain Suffix dialog, enter the domain name assigned by your Service Provider or ISP (for example, “abc.company.com”).
4. Click Add.

Note
The domain name in the illustration is an example only. Ask your Service Provider or ISP for the name you should enter.

5. If you have a secondary domain name (suffix), repeat Step 2., Step 3., and Step 4.
6. On the Advanced TCP/IP Settings dialog, click OK.

The Internet Protocol (TCP/IP) Properties dialog appears, showing the DNS server addresses that you entered.

7. On the Internet Protocol (TCP/IP) Properties dialog, click OK.

8. In the GS Packet Data Properties dialog, click OK.

You have finished creating your new connection for Windows 2000. To make a Globalstar connection, go to the next section, “Making a Globalstar Packet Data Connection” on page 40.
Making a Globalstar Packet Data Connection

⚠️ Caution

On your computer, make sure that no other application is using the serial port (e.g., COM1) assigned for Globalstar Packet Data. If another application, such as Palm HotSync Manager, blocks the serial port, disable its control over the port before attempting a Globalstar Packet Data connection.

To make a packet data connection

1. Make sure the Tri-Mode Phone is properly connected to your PC or laptop (as described in “Connecting Windows Components” on page 5).
2. Turn on your Tri-Mode Phone.
3. Extend the Tri-Mode Phone’s Globalstar Satellite Antenna and make sure you have a Globalstar signal.
4. On your computer, double-click the icon you created for your packet data connection (for instance, “GS Packet Data”).
5. When the Connect To dialog opens, click Connect.
   or
   For Windows 2000: Click Dial.
   (Leave the User name and Password fields blank.)

While the Tri-Mode Phone is establishing the packet data connection, the Tri-Mode Phone screen looks like this:

You are connected to the network when the Verifying Username and Password window on your computer minimizes and the Tri-Mode Phone screen says “PPP @ 9.6.” The “PPP @ 9.6” indicates that the over-the-air data rate is 9600 bps. (The “T R” status stands for Transmit and Receive.)

You can now open typical communication applications to do anything you would normally do through an Internet Service Provider (ISP).
To disconnect a packet data connection

1. Double-click the packet data connection (or the connection icon in the right-hand bottom corner of the screen).
2. Click Disconnect.

Using Typical Communication Applications

Once you have established a Globalstar packet data service connection, you can use any communication applications using IP network protocol, for instance Internet Web browsers, e-mail, FTP, or telnet applications.

The CD that came with your QUALCOMM Globalstar Packet Data Kit may include some typical communication applications for Windows, such as Eudora, Netscape Navigator, or Microsoft Internet Explorer.
This chapter tells how to configure an Apple Macintosh computer to use Globalstar packet data service. To do this, you physically connect the Macintosh to your QUALCOMM Globalstar Tri-Mode Phone, select a modem script, and configure remote access.

You can use Globalstar packet data service with a Macintosh running OS 7.6 or higher.

**Note**

The following examples use Macintosh OS 9. Setup for other OS versions and PPP applications may vary.

**Connecting Macintosh Components**

To use Globalstar packet data service with a Macintosh, you connect the following hardware components:

- Macintosh computer
- Macintosh modem cable (round DIN 8 or USB on the Macintosh end). See Table 1 on page 82 for required pinout configurations.
- Adapter (25-pin female to 9-pin male). See Table 1 on page 82 for required pinout configurations.
- QUALCOMM serial data cable (included in QUALCOMM Globalstar Packet Data Kit)
- QUALCOMM Globalstar GSP-1600 Tri-Mode Phone
To connect a Macintosh computer to the Tri-Mode Phone

1. Turn off the power on your QUALCOMM Globalstar Tri-Mode Phone. You can leave your computer turned on.

2. Connect the 8-pin/USB end of the Macintosh modem cable to the modem port on your Macintosh.

3. Connect the 25-pin female end of the adapter to the 25-pin serial connector of the Macintosh modem cable.

4. Attach the 9-pin serial connector of the QUALCOMM data cable to the 9-pin male end of the adapter, then manually tighten the screws to hold it in place.

Note
Newer Macintosh computers use a USB to 9-pin modem cable.

3. Connect the 25-pin female end of the adapter to the 25-pin serial connector of the Macintosh modem cable.

4. Attach the 9-pin serial connector of the QUALCOMM data cable to the 9-pin male end of the adapter, then manually tighten the screws to hold it in place.
5. Holding the other end of the QUALCOMM data cable, press both buttons on the side of the connector, then insert it into your Tri-Mode Phone with the arrow facing up (toward the phone’s keypad). The connector should snap into place for a secure fit.

6. Turn on your Tri-Mode Phone.

7. Extend the Globalstar Satellite Antenna to a 90° position.

Note
If you cannot obtain a signal with the Globalstar Satellite Antenna in a 90° position, try rotating it further until you feel it click into place.
Configuring Your Macintosh

To configure a Macintosh computer to use Globalstar packet data service, you do the following:

■ Copy the modem script file to your Macintosh.
■ Configure remote access.
■ Configure the protocol and modem settings.

Copying the Modem Script File to Your Macintosh

1. Locate the CD included in the QUALCOMM Globalstar Packet Data Kit, then insert it into the CD-ROM drive of your Macintosh.
2. Using the Finder, copy the “QUALCOMM Globalstar Phone Modem” file from the CD to: System Folder > Extensions > Modem Scripts.
   The “QUALCOMM Globalstar Phone Modem” file is a script containing modem settings that work with Globalstar packet data service.

Configuring Remote Access

Creating a New Configuration

1. From the Apple menu, select Control Panels, then select Remote Access. The Remote Access dialog appears showing the last active setting.
2. From the Remote Access pulldown menu, select File > Configurations.
3. If the Configurations dialog appears (meaning that some Remote Access configuration already exists), select “Default” from the configuration list.
   If Remote Access has not been configured previously, a wizard appears to guide you through a process similar to what is documented here.
4. Click Duplicate.
5. In the **Duplicate Configuration** dialog, type “GS Packet Data” as the name for the duplicate configuration.

6. Click **OK**.

7. In the **Configurations** dialog, select your new GS Packet Data configuration in the list.

8. Click **Make Active**.

9. Click **Done** to accept the changes and close the **Configurations** dialog.
Setting Up Remote Access

1. In the Remote Access (GS Packet Data) dialog, select “Setup” to see all the fields.

2. In the “Name” field, type your user name.
   You must fill in this field to activate the Connect button.
3. Leave the “Password” field blank.
4. In the “Number” field, type “#777.”
   “#777” is a special number that tells the Tri-Mode Phone to make a packet data connection.
5. Click Options.
Setting Up the Protocol

1. In the Options dialog, click the Protocol tab.
2. Under “Use protocol,” select “PPP.”
   Globalstar packet data service uses Point-to-Point Protocol (PPP) to carry data packets from your computer to the Globalstar Gateway.
3. Select “Connect automatically when starting TCP/IP applications.”
4. Select “Allow error correction and compression in modem.”
5. Select “Use TCP header compression.”
6. Make sure all other check boxes are cleared (not selected).

Note
   Leave the Redialing and Connection tabs set to their defaults unless otherwise instructed by your ISP.

7. Click OK to accept the changes and close the Options dialog.
Setting Up the New Modem

1. In the Modem (GS Packet Data) dialog, in the “Connect via” field, select “the port you connected the modem cable to.”
2. From the “Modem” list, select QUALCOMM Globalstar Phone Modem.

**Tip**
The baud rate for the “QUALCOMM Globalstar Phone Modem” modem is 38400 bps. The baud rate on your Tri-Mode Phone must also be 38400 bps, or your computer cannot communicate with the Tri-Mode Phone. You can check the baud rate on your Tri-Mode Phone by selecting menu, selecting Features > Data > Baud Rate, then changing the baud rate to 38400 bps if necessary.

**Note**
38400 bps is the speed at which the Tri-Mode Phone communicates with your computer, not the speed at which it communicates with the Gateway.

3. In the “Sound” field, select “On.”
4. In the “Dialing” field, select “Tone.”
5. Make sure “Ignore Dial Tone” is not checked.

6. Close the Modem (GS Packet Data) dialog.

Creating a TCP/IP Packet Data Connection

1. From the Remote Access pulldown menu, select Remote Access > TCP/IP.
2. From the Remote Access pulldown menu, select File > Configurations.
3. Select “Default” from the configuration list.
4. Click Duplicate.
5. In the **Duplicate Configuration** dialog, type “GS Packet Data” as the name for the duplicate configuration.

6. Click **OK**.

7. In the **Configurations** dialog, select your new GS Packet Data configuration in the list.

8. Click **Make Active**.

9. Click **Done** to accept the changes and close the **Configurations** dialog.
Setting Up a TCP/IP Packet Data Connection

1. In the TCP/IP (GS Packet Data) dialog, under “Connect via:” select “PPP.” Globalstar packet data service uses Point-to-Point Protocol (PPP) to carry data packets from your computer to the Globalstar Gateway.

2. In the “Configure” list, select “Using PPP Server.”

3. In most cases you should allow the server to set addresses and masks. Contact your ISP to find out what information is required.

4. In the “Name server addr.:” field, enter the primary and secondary DNS addresses assigned by your Service Provider or ISP.

   **Note**
   Name server address numbers in the illustration are examples only. Ask your Service Provider or ISP for the numbers you should enter.

5. In the “Search domains” field, enter the domain name assigned by your Service Provider or ISP.

6. Close the TCP/IP (Packet Data) dialog.
Caution
On your computer, make sure that no other application is using the modem port assigned for Globalstar packet data. If another application such as the Palm HotSync Manager blocks the port, disable its control over the port before attempting a Globalstar packet data connection.

To make a packet data connection
1. Make sure the Tri-Mode Phone is properly connected to your Macintosh computer (as described in “Connecting Macintosh Components” on page 43).
2. Turn on your Tri-Mode Phone.
3. Extend the Tri-Mode Phone’s Globalstar Satellite Antenna and make sure you have a Globalstar signal.
4. From the Apple menu, select Remote Access Status.
5. In the Remote Access dialog, click Connect.
6. Remote Access prompts you for your password. If you use one, enter it; if you do not use a password, leave the box blank.
7. Click OK.

While the Tri-Mode Phone is establishing the packet data connection, the Tri-Mode Phone screen looks like this:

You are connected to the network when Remote Access Status on your Macintosh says “Connected,” the Connect button changes to Disconnect,
and the Tri-Mode Phone screen says “PPP @ 9.6.” The “PPP @ 9.6” indicates that the over-the-air data rate is 9600 bps. (The “T R” status stands for Transmit and Receive.)

You can now open typical communication applications to do anything you would normally do through an Internet Service Provider (ISP).

**To disconnect a packet data connection**

1. From the Apple menu, select Remote Access Status.
2. In the Remote Access dialog, click Disconnect.

**Using Typical Communication Applications**

Once you have established a Globalstar packet data service connection, you can use any communication applications based on IP network protocol, for instance Internet Web browsers, e-mail, FTP, or telnet applications.

The CD that came with your QUALCOMM Globalstar Packet Data Kit may include some typical communication applications for Macintosh, such as Eudora and Netscape Navigator.
This chapter tells how to configure a Palm handheld organizer running the Palm OS to use Globalstar packet data service. To do this, you physically connect the Palm handheld to your QUALCOMM Globalstar Tri-Mode Phone, then set up a wireless “modem” and a network connection.

Configuration procedures are similar for all models of Palm handhelds (III, V, VII). However, to connect different models you may need different cables or optional adapters.

**Note**
The examples in this chapter use Palm OS 3.1.1. You may need a newer Palm OS, depending on which Palm you use, and newer Palm OS versions may differ from the examples here.

**Connecting Palm Components**
To use Globalstar packet data service with a Palm, you connect the following hardware components:

- Palm handheld organizer or PalmPilot
- HotSync cable (be sure you have the correct cable for your Palm model)
- Null modem adapter, male 9-pin on both ends
- QUALCOMM serial data cable (included in QUALCOMM Globalstar Packet Data Kit)
- QUALCOMM Globalstar GSP-1600 Tri-Mode Phone
To connect a Palm handheld to the Tri-Mode Phone

1. Turn off the power on your QUALCOMM Globalstar Tri-Mode Phone.
2. Connect the serial connector on the HotSync cable to your Palm.

![Serial connector](image1.png)

3. Connect the null modem adapter to the other end of the HotSync cable.

![HotSync cable and connector](image2.png)

4. Connect the 9-pin serial end of the Globalstar data cable to the null modem adapter, and manually tighten the screws to hold it in place.

![9 pin serial connector](image3.png)

5. Holding the other end of the data cable, press both buttons on the side of the connector, then insert it into your Tri-Mode Phone with the arrow facing up (toward the phone's keypad). The connector should snap into place for a secure fit.

![Globalstar data cable](image4.png)

6. Turn on your Tri-Mode Phone.
7. Extend the Globalstar Satellite Antenna to a 90° position.

Note
If you cannot obtain a signal with the Globalstar Satellite Antenna in a 90° position, try rotating it further until you feel it click into place.

Configuring Your Palm Handheld

To configure a Palm handheld computer to use Globalstar packet data service, you must set up the following:

- A wireless “modem”
- A network connection

Setting Up a Modem

1. On your Palm handheld, tap the Applications (or Home) icon.
2. Tap Prefs.
3. On the Preferences screen, tap the Categories menu and select Modem.

Note
For some Palm OS versions, Preferences/Connection replaces Preferences/Modem.

4. Tap Modem and select Standard.
5. Tap **Speed** and select **38,400 bps**.

The speed for the modem must match the baud rate on your Tri-Mode Phone (38400 bps is the phone’s default). If the speeds are not the same, your computer cannot communicate with the Tri-Mode Phone.

**Tip**

You can check or change the baud rate on your Tri-Mode Phone by selecting **menu**, then selecting **Features > Data > Baud Rate**. If the baud rate on your Tri-Mode Phone is not set to 38400 bps, be sure to change the modem’s speed so that the two speeds match.

**Note**

38400 bps is the speed at which the Tri-Mode Phone communicates with your Palm handheld, not the speed at which it communicates with the Gateway.

6. Set “Speaker” to “Off.”
7. Set “Flow Ctrl” to “On.”
8. In the “String” field, keep the default string. (Alternatively, you can clear the string, in which case “Modem” changes from “Standard” to “Custom.” Either way should work.)

**Note**

Make sure the String field does not include any AT commands that the Tri-Mode Phone does not support for packet data. See “Supported AT Commands” on page 87.

9. Make sure “TouchTone” is highlighted.
Wireless modem setup is complete. Next you set up the network connection.

**Setting Up Your Network Connection**

**Configuring a New Network Service**

1. On the **Preferences** screen, tap the Categories menu and select **Network**.
2. Tap **Service** and create a new network service called “GS Packet Data.”

**Note**
For some Palm OS versions there is a “Connection” field that is the name of the modem you are using.

3. “User Name” should remain blank and “Password” should read “-Prompt-”.

**Note**
In the “Password” field, “-Prompt-” indicates that if a password is required for connecting to your e-mail or other applications, you will be prompted for it at connection time.
Configuring Phone Setup
1. On the Preferences/Network screen, tap the “Phone” field.
2. On the Phone Setup screen, in the “Phone #” field, enter “#777.”
   “#777” is a special number that tells the phone to make a packet data connection.
3. Clear all the other checkboxes.
4. Tap OK.

Configuring Network Details
1. On the Preferences/Network screen, tap Details....
2. On the Details screen, make sure the “Connection type” is “PPP.”
   Globalstar packet data service uses Point-to-Point Protocol (PPP) to carry data packets from your computer to the Globalstar Gateway.
3. Make sure “Idle timeout” is set to “Power Off.”
4. Make sure “Query DNS” is not checked, so that the “Primary DNS” and “Secondary DNS” fields appear.
5. In the “Primary DNS” and “Secondary DNS” fields, enter the DNS addresses assigned by your Service Provider or ISP.

Note
DNS address numbers in the illustration are examples only. Ask your Service Provider or ISP for the numbers you should enter.

6. Make sure “IP Address” is checked (“Automatic”).
7. Tap OK.
Making a Globalstar Packet Data Connection

To make a packet data connection

1. Make sure the Tri-Mode Phone is properly connected to your Palm handheld (as described in “Connecting Palm Components” on page 55).
2. Power up your Tri-Mode Phone.
3. Extend the Tri-Mode Phone’s Globalstar Satellite Antenna and make sure you have a Globalstar signal.
4. On your Palm handheld, go to the Preferences/Network screen and tap Connect.

On your Palm handheld, the Service Connection Progress dialog appears.
While the Tri-Mode Phone is establishing a packet data connection, the Tri-Mode Phone screen looks like this:

![Screen Shot]

You are connected to the network when the Service Connection Progress dialog says “Signing on, Established,” and then disappears, the Connect button changes to Disconnect, and the Tri-Mode Phone screen says “PPP @ 9.6.” The “PPP @ 9.6” indicates that the over-the-air data rate is 9600 bps. (The “T R” status stands for Transmit and Receive.)

![Screen Shot]

You can now open typical communication applications to do anything you would normally do through an Internet Service Provider (ISP).
To disconnect a packet data connection

1. On your Palm handheld, go to the Preferences/Network screen and tap Disconnect.

Using Palm Communication Applications

Once you have established a Globalstar packet data service connection, you can use any communication applications based on IP network protocol. For instance, pdQsuite provides e-mail and Web browsing applications for Palm handhelds.

Note
Some Web sites may not format pages for a Palm browser.
This chapter tells how to configure a UNIX computer to use Globalstar packet data service. To do this, you physically connect the UNIX computer to your QUALCOMM Globalstar Tri-Mode Phone, then configure a “modem” and packet data or PPP connection.

Globalstar packet data service has been tested with the following:

- Solaris UNIX
- Red Hat Linux

Note

The examples in this chapter use Solaris version 2.6 and Red Hat Linux 6.1. Setup for other UNIX OS versions and PPP applications may vary.

Connecting UNIX Components

To use Globalstar packet data service with UNIX, you connect the following hardware components:

- UNIX computer running Solaris or Red Hat Linux
- QUALCOMM serial data cable (included in QUALCOMM Globalstar Packet Data Kit)
- QUALCOMM Globalstar GSP-1600 Tri-Mode Phone
To connect a UNIX computer to the Tri-Mode Phone

1. Turn off the power on your Tri-Mode Phone. You can leave your computer on.

2. Attach the QUALCOMM data cable's 9-pin serial connector to a COM serial port (RS-232) on your workstation, and manually tighten the screws to hold it in place.

   **Note**
   
   Some computers may require an additional adapter if a 9-pin serial port is not available for connecting the QUALCOMM data cable.

3. Holding the other end of the QUALCOMM data cable, press both buttons on the side of the connector, then insert it into your Tri-Mode Phone with the arrow facing up (toward the phone's keypad). The connector should snap into place for a secure fit.

4. Turn on your Tri-Mode Phone.

5. Extend the Globalstar Satellite Antenna to a 90° position.
Note
If you cannot obtain a signal with the Globalstar Satellite Antenna in a 90° position, try rotating it further until you feel it click into place.

Configuring Your Solaris UNIX Computer

You can interact with a Solaris UNIX system in many ways, from the command line to various graphical interfaces. No matter which interface you use, you must provide the same basic information to configure Globalstar packet data service.

The configuration procedures in this section use Solstice PPP 3.0.1 as an example. A license and software for Solstice PPP is included with your purchase of the Solaris media. To install Solstice PPP, see the instructions in your Solaris documentation.

Setting Up the PPP Client
1. Log in as root or become superuser.
2. From the command line, type /usr/bin/pppinit and press Enter.
4. Select “Modem Configuration.”
5. Select “[19] - Standard Hayes modem.”
6. Press Enter to set the serial port to default.
7. For the “Name of the remote server,” type gs_packet_data and press Enter. This confirms the name of the script but does not create one.
8. For “Phone number for this server,” type T#777 and press Enter. The letter T sets the phone up for tone dialing. The numbers #777 tell the Gateway to set up a packet data connection.
9. For “Filename of the chat script” press Enter to accept the default. Globalstar packet data does not use chat scripts. Selecting no means no script will be created.
10. When asked to create a template file, press n for no.

Note
Some PPP software may require that a chat script exist. After finishing this setup, you will need to “touch” the script named in Step 9.

11. For “Enter your IP address” press Enter for none.
12. For “Enter your Server IP address” press Enter for none. Leaving these fields blank allows the server to set the addresses.
13. For “IP netmask for this interface” press Enter for none.
14. For “Enter your PAP Id” press Enter for none.
15. For “Enter your CHAP Name” press Enter for none.
16. For “Inactivity timeout” press Enter for the default of 120 seconds.
17. For “Do you want to add an access to another server?” press n for no.
18. Press E to save your changes and exit pppinit.

**Enabling Domain Name Service**

Before you can enable Domain Name Service (DNS), your ISP must provide the following information:

- The domain name of the subnetwork
- The IP addresses of your name servers

1. Edit the file `/etc/nsswitch.conf`.
2. For “hosts,” type `files dns` and press Enter.
3. Create the file `/etc/resolv.conf`.
4. For “domain,” type the domain name (for example, abc.company.com) and press Enter.
5. For the first “nameserver,” type the primary DNS (for example, 123.123.123.123) and press Enter.
6. For the second “nameserver,” type the secondary DNS (for example, 122.122.122.122) and press Enter.
7. Press Enter twice to invoke the changes.

Changes take place automatically.

**Completing the Setup**

1. From the command line, “touch” the chat script, in this case `/etc/opt/SUMWconn/ppp/script/gs_packet_data.scr`. This creates an empty script file. If the file already exists, open it with a text editor and make sure that it contains no lines of text.
2. Check the `/etc/opt/SUMWconn/ppp/link.conf` file and make sure the speed is set to 38400.

The speed for the PPP client must match the baud rate on your Tri-Mode Phone (38400 bps is the phone’s default). If the speeds are not the same, your computer cannot communicate with the Tri-Mode Phone.

**Tip**

You can check or change the baud rate on your Tri-Mode Phone by selecting menu, then selecting Features > Data > Baud Rate. If the baud rate on your Tri-Mode Phone is not set to 38400 bps, be sure to change the line speed for the PPP client so that the two speeds match.
Note
38400 bps is the speed at which the Tri-Mode Phone communicates with your computer, not the speed at which it communicates with the Gateway.

3. Type exit to log out as root and invoke the changes.

Checking the GS Packet Data Setup
1. Log in as you normally would (root not required).
2. From the command line, type /usr/bin/ppp tool and press Enter. The information you provided to pppinit now appears in ppp tool.
3. Double-click the host icon you want to connect to. This is the name of the remote server you entered in pppinit: gs_packet_data.
4. In the Connection window, the “Phone number” field should read “T#777.”
5. The “Local IP address” field should read “unassigned.”
6. The “Remote IP address” field should read “unassigned.” Leaving these fields “unassigned” allows the server to assign the addresses.
7. The “Local inactivity timeout” field should read “120 second(s).” This is the time the connection can remain unused before it automatically closes.

Making a Globalstar Packet Data Connection
To make a packet data connection
1. Make sure the Tri-Mode Phone is properly connected to your UNIX computer (as described in “Connecting UNIX Components” on page 65).
2. Power up your Tri-Mode Phone.
3. Extend the Tri-Mode Phone’s Globalstar Satellite Antenna and make sure you have a Globalstar signal.
4. In ppp tool, double-click the host icon you want to connect to.
5. In the Connection window, click Connect. The Tri-Mode Phone makes the data call. While the call is connecting, the Tri-Mode Phone screen looks like this:

You are connected to the network when the Status line reads “Connected,” the Disconnect button become active, and the Tri-Mode
Phone screen says “PPP @ 9.6.” The “PPP @ 9.6” indicates that the over-the-air data rate is 9600 bps. (The “T R” status stands for Transmit and Receive.)

You can now open typical communication applications to do anything you would normally do through an Internet Service Provider (ISP).

To disconnect a Globalstar packet data connection
1. Double-click the host icon you want to disconnect from.
2. In the Connection window, click Disconnect.
   The connection is closed, the Status line reads “Disconnected,” and the Connect button becomes active.

Configuring Your Linux Computer
You can interact with Linux systems in many ways, from the command line to various graphical interfaces. No matter which interface you use, you must provide the same basic information to configure Globalstar packet data service.

The configuration procedures in this section use Netconf, a part of the LinuxConf suite, as an example and assume that both Netconf and PPP are installed. To install Netconf and PPP, see the instructions in your Linux documentation.

Setting Up the Modem and PPP Connection
Using Netconf, you can set up a modem and a PPP connection in the same series of steps.
1. Log in as root.
2. Run netconf.
3. Click **PPP/SLIP/PLIP** to open the **Configurations** dialog.

![Configurations dialog](image)

4. In the **Configurations** dialog, click **Add**.

![Add configuration](image)

5. Select **PPP** and click **Accept**.

![PPP selection](image)
6. In the “Phone number” field, type “#777.”

7. Select the modem port you have connected the Tri-Mode Phone to. In most cases it should be the default port.

8. Leave the “Use PAP authentication” and the “Login name” and “Password” fields blank unless your ISP tells you to fill them in.

9. Click Accept.

The Configurations dialog now has a new entry, “ppp0.”

Configuring the PPP Connection

1. In the Configurations dialog, double-click ppp0.

2. On the Hardware tab, select all of the checkboxes except “Escape control characters.”

3. Set “Line speed” to 38400. The line speed for the PPP connection must match the baud rate on your Tri-Mode Phone (38400 bps is the phone’s default). If the speeds are not the same, your computer cannot communicate with the Tri-Mode Phone.

Tip
You can check or change the baud rate on your Tri-Mode Phone by selecting menu, then selecting Features > Data > Baud Rate. If the baud rate on your Tri-Mode Phone is not set to 38400 bps, be sure to change the line speed for the PPP connection so that the two speeds match.
Note

38400 bps is the speed at which the Tri-Mode Phone communicates with your computer, not the speed at which it communicates with the Gateway.

4. The modem port should be set to the port you chose previously.

5. On the Communication tab, make sure that “Modem init string” and “Modem dial command” do not include any AT commands that the Tri-Mode Phone does not support for packet data. (See “Supported AT Commands” on page 87.)

6. Make sure that #777 appears in the “Phone number” field.

7. Clear all fields in the “Chat” section.
8. The **Networking** tab should not require any changes.

9. Leave the **PAP** tab blank.
10. Click **Accept**.
Configuring the Name Server

1. In the Configurations dialog, click Quit.
2. On the Netconf screen, click Name Server Specification (DNS).
3. In the “default: domain” field, enter the domain name assigned by your Service Provider or ISP.
4. In the “nameserver 1” and “nameserver 2” fields, enter the DNS addresses assigned by your Service Provider or ISP.

Note
The domain name and DNS addresses in the illustration are examples only. Ask your Service Provider or ISP for the numbers you should enter.

5. Click Accept.
Saving Your Settings

1. On the Netconf screen, click Quit.
2. On the activation dialog that appears, click Activate the changes.
3. Type `exit` to log out as root.

Your computer is now ready to make a packet data connection.
Making a Globalstar Packet Data Connection

To make a packet data connection

1. Make sure the Tri-Mode Phone is properly connected to your Linux computer (as described in “Connecting UNIX Components” on page 65).
2. Power up your Tri-Mode Phone.
3. Extend the Tri-Mode Phone’s Globalstar Satellite Antenna and make sure you have a Globalstar signal.
4. On the command line of your computer, type `usernetctl ppp0 up` and press Enter.

The Tri-Mode Phone makes the data call. While the call is connecting, the Tri-Mode Phone screen looks like this:

You are connected to the network when the Tri-Mode Phone screen says “PPP @ 9.6.” The “PPP @ 9.6” indicates that the over-the-air data rate is 9600 bps. (The “T R” status stands for Transmit and Receive.) When the connection is made, the status is logged to the system log.

You can now open typical communication applications to do anything you would normally do through an Internet Service Provider (ISP).

To disconnect a packet data connection

1. On the command line of your computer, type `usernetctl ppp0 down` and press Enter.

The connection is closed and the status is logged to the system log.
QUALCOMM Globalstar Hands-Free Car Kit

You can use Globalstar packet data service in a vehicle equipped with a QUALCOMM Globalstar Hands-Free Car Kit.

Connecting Car Kit Components

To use Globalstar packet data service with a QUALCOMM Globalstar Hands-Free Car Kit, the car kit should be installed as usual for your QUALCOMM Globalstar Tri-Mode Phone. For details, see the QUALCOMM Globalstar GCK-1400 Hands-Free Car Kit Installation/User Guide (document number 80-98438-1).

In addition, you connect the following hardware components:

- A laptop or handheld computer
- A serial cable with a male 9-pin connector on one end and a female 9-pin connector on the other
- Other cables or adapters, if required for your specific computer
To connect a computer or Palm handheld to the car kit

1. Attach the 9-pin connector of the serial cable to the 9-pin serial port on the GEM (Globalstar Electronic Module) box of the car kit.

2. Attach the other end of the serial cable to a 9-pin COM port (RS-232) on your Windows or UNIX computer.
   or
   Attach the other end of the serial cable to adapters or additional cables, as required, for your Macintosh computer or Palm handheld. See “Connecting Macintosh Components” on page 43 or “Connecting Palm Components” on page 55 for details.
Commercially Available Accessories

The QUALCOMM Globalstar Packet Data Kit includes the following accessories:

- QUALCOMM serial data cable
- Compact Disc (CD-ROM) that includes this User Guide

This chapter describes optional accessories that you may need to complete your hardware setup, depending on which computer you use. These accessories are readily available from commercial retail outlets that carry computer supplies, for example electronics, computer, or office supply stores such as (but not limited to) Radio Shack, CompUSA, Staples, or Office Depot.

Indoor/Outdoor Extension Cable

An extension cable lets you place the Tri-Mode Phone outdoors and connect it to a computer inside a building, to avoid sun glare and make the computer screen easier to read. The cable should have a 9-pin male connector on one end and a 9-pin female on the other, with a maximum length of 30 meters.

Palm Cable and Null Modem Adapter

If you are using a Palm handheld without a built-in 9-pin D serial port, you need a cable and adapter to interface with the QUALCOMM data cable for the Tri-Mode Phone (TIA/EIA-574 DTE serial interface).

A Palm cable connects a Palm handheld to a null modem adapter, which attaches to the QUALCOMM data cable. Depending on the Palm model, this may be a HotSync cable or other type of Palm cable. For connection details, see “Connecting Palm Components” on page 55.

The null modem adapter (for a TIA/EIA-574 DTE serial interface) should have 9-pin male connectors on each end. Alternatively, you could use a 9-pin male-to-female null modem adapter and a gender-changer adapter to connect to the Palm. (Most commercially available null modem adapters are male-to-female.)

Macintosh Modem Cable and Adapter

If you are using an Apple Macintosh without a built-in 9-pin D serial port, you need a cable and adapter to interface with the QUALCOMM data cable for the Tri-Mode Phone (TIA/EIA-574 DTE serial interface).

A Macintosh modem cable lets you connect your Macintosh computer to the QUALCOMM data cable. The cable should have a 25-pin female connector on one end, and either a round DIN 8 connector on the other, or, if your Macintosh has a USB (Universal Serial Bus) port, a USB connector on the other.

Completing the connection also requires a adapter between the 25-pin end of the Macintosh modem cable and the 9-pin end of the QUALCOMM data...
cable. For connection details, see “Connecting Macintosh Components” on page 43.

Both the Macintosh modem cable and the adapter must have specific pin configurations to work with Globalstar packet data. For pinout details, see Table 1 on page 82.

<table>
<thead>
<tr>
<th>Mini-DIN-8</th>
<th>Apple Signal</th>
<th>EIA-232 Signal</th>
<th>DB-25 pin</th>
<th>EIA-574 DE-9 pin</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>HSKo</td>
<td>RTS/RFR and DTR</td>
<td>4 and 20</td>
<td>7 and 4</td>
</tr>
<tr>
<td>2</td>
<td>HSKi</td>
<td>CTS</td>
<td>5</td>
<td>8</td>
</tr>
<tr>
<td>3</td>
<td>TxD–</td>
<td>TxD</td>
<td>2</td>
<td>3</td>
</tr>
<tr>
<td>4</td>
<td>GND</td>
<td>GND</td>
<td>7</td>
<td>5</td>
</tr>
<tr>
<td>5</td>
<td>RxD–</td>
<td>RxD</td>
<td>3</td>
<td>2</td>
</tr>
<tr>
<td>6</td>
<td>TxD+</td>
<td>NC</td>
<td>NC</td>
<td>NC</td>
</tr>
<tr>
<td>7</td>
<td>GPi</td>
<td>RLSD (DCD)</td>
<td>8</td>
<td>1</td>
</tr>
<tr>
<td>8</td>
<td>RxD+</td>
<td>GND</td>
<td>7</td>
<td>5</td>
</tr>
</tbody>
</table>

QUALCOMM Globalstar Hands-Free Car Kit Cable

To use Globalstar packet data service in a vehicle equipped with a QUALCOMM Globalstar Hands-Free Car Kit, you need one additional cable: a serial cable with a male 9-pin connector on one end and a female 9-pin connector on the other. This is the same type of cable as the optional extension cable, only shorter.

This cable connects the GEM (Globalstar Electronic Module) box of the car kit to a laptop computer. For connection details, see “Connecting Car Kit Components” on page 79.
If you are having a problem with Globalstar packet data service, try the following troubleshooting tips. If that does not solve the problem, contact your service provider's customer care center.

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td>Make sure the Tri-Mode Phone's battery is charged and properly installed.</td>
</tr>
<tr>
<td>Your Tri-Mode Phone cannot get a Globalstar signal.</td>
<td>Make sure the Tri-Mode Phone is outdoors.</td>
</tr>
<tr>
<td></td>
<td>Extend the Globalstar Satellite Antenna at least 90º, or, if that does not work, rotate it further until you feel it click into place.</td>
</tr>
<tr>
<td></td>
<td>Position the Tri-Mode Phone so the Globalstar Satellite Antenna points straight up to the sky.</td>
</tr>
<tr>
<td></td>
<td>Make sure the Globalstar Satellite Antenna has a clear view of the sky, not blocked by tall obstacles such as buildings and trees.</td>
</tr>
<tr>
<td>Your Tri-Mode Phone has a Globalstar signal but you cannot connect to the data network.</td>
<td>Make sure the Tri-Mode Phone and your computer are connected correctly and make sure all connectors are tight (see the appropriate chapter for your type of computer).</td>
</tr>
<tr>
<td></td>
<td>Check your modem and network settings (see the appropriate chapter for your type of computer).</td>
</tr>
<tr>
<td></td>
<td>Make sure the telephone number being dialed is #777.</td>
</tr>
<tr>
<td>Problem</td>
<td>Solution</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Nothing happens on the Tri-Mode Phone when you try to connect, a message says “No dial tone,” or a message says “hardware failure.” | - Make sure the baud rate in your “GS packet data” modem settings matches the baud rate on your Tri-Mode Phone (default: 38400). Check the baud rate on your Tri-Mode Phone by selecting menu > Features > Data > Baud Rate, then change it if necessary.  
- Make sure the battery for the laptop or Palm handheld is charged, or that the laptop or Palm is properly plugged into a power supply. It is possible to have a low battery charge that will run the laptop but will not drive the serial port. |
| You have a PPP connection but your Internet applications cannot connect to your ISP. | - Your Internet applications must be set up for your ISP. Check these settings and contact your ISP for further information. |
| Windows Computers                                                                                     |                                                                                                  |
| Your Tri-Mode Phone has a Globalstar signal but you cannot connect to the data network.                | - Make sure that Maximum Speed for your GS packet data “modem” matches the baud rate on your Tri-Mode Phone. Check the baud rate on your Tri-Mode Phone by selecting menu > Features > Data > Baud Rate, then change it if necessary.  
- Make sure the number being dialed is #777. If the # character does not appear in the dial string, you can type it in manually before connecting. For a more permanent fix, see “Setting Dial Properties” on page 22.  
- Make sure you have selected the COM port to which the Tri-Mode Phone is connected. (See “Selecting the COM Port” on page 10.)  
- On your computer, make sure that no other application is using the serial port (e.g., COM1) assigned for Globalstar packet data. If another application, such as Palm HotSync Manager, blocks the serial port, disable its control over the port before attempting a Globalstar packet data connection. |
<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Your serial mouse does not function properly.</td>
<td>■ A COM port conflict may exist. Make sure you have properly configured the COM port to which the Tri-Mode Phone is attached. Refer to your computer's manual for additional assistance on managing COM ports.</td>
</tr>
<tr>
<td>Your computer locks up when accessing the Tri-Mode Phone.</td>
<td>■ A conflict with COM ports and IRQs may exist. Refer to your computer's manual for additional assistance.</td>
</tr>
<tr>
<td>Macintosh Computers</td>
<td></td>
</tr>
<tr>
<td>Your Tri-Mode Phone has a Globalstar signal but you cannot connect to the data network.</td>
<td>■ Make sure the baud rate on your Tri-Mode Phone matches that for the “QUALCOMM Globalstar Phone Modem.” Check the baud rate on your Tri-Mode Phone by selecting menu &gt; Features &gt; Data &gt; Baud Rate, then change it to 38400 bps if necessary.</td>
</tr>
<tr>
<td></td>
<td>■ On your computer, make sure that no other application is using the modem port assigned for Globalstar packet data. If another application, such as Palm HotSync Manager, blocks the port, disable its control over the port before attempting a Globalstar packet data connection.</td>
</tr>
<tr>
<td>Palm Handhelds</td>
<td></td>
</tr>
<tr>
<td>The Palm tries to connect but the Tri-Mode Phone does not respond.</td>
<td>■ Make sure you have a current Palm operating system (OS) installed. Sometimes a newer Palm model running an older OS version cannot make data connections properly.</td>
</tr>
</tbody>
</table>
|                                                                       | ■ Make sure the String field under Preferences/Modem does not include any AT commands that the Tri-Mode Phone does not support for packet data. (See “Setting Up a Modem” on page 57 and “Supported AT Commands” on page 87.)
### Problem
You have a connection but your browser cannot access a Web page, or you are having authentication problems not due to user name/password errors.

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ If Web pages use CHAP (Challenge Handshake Authentication Protocol), you may need to upgrade your Palm OS to work with them.</td>
</tr>
</tbody>
</table>

### UNIX Computers
The computer tries to connect but the Tri-Mode Phone does not respond.

<table>
<thead>
<tr>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>■ Make sure the PPP daemon is running (see the PPP documentation).</td>
</tr>
<tr>
<td>■ Make sure the modem initialization string and dial commands do not include any AT commands that the Tri-Mode Phone does not support for packet data. (See “Supported AT Commands” on page 87.)</td>
</tr>
<tr>
<td>■ Make sure the baud rate for your GS packet data “modem” matches the baud rate on your Tri-Mode Phone. Check the baud rate on your Tri-Mode Phone by selecting menu &gt; Features &gt; Data &gt; Baud Rate, then change it if necessary.</td>
</tr>
</tbody>
</table>
For Globalstar packet data service, your QUALCOMM Globalstar Tri-Mode Phone works as a wireless modem. In other words, it functions as Data Circuit-Terminating Equipment (DCE) that communicates with your computer, or Data Terminal Equipment (DTE).

In the process, your computer sends AT commands to the Tri-Mode Phone. Table 2 shows the AT (Hayes modem compatible) commands that the Tri-Mode Phone supports for packet data.

**Note**

Table 2 uses the following notations:

- X = command is ignored
- NA = not applicable

### Table 2. Supported AT Commands

<table>
<thead>
<tr>
<th>AT Command and Syntax</th>
<th>AT Command Description (brief)</th>
<th>Value Range</th>
<th>Default If No Value Is Defined</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>E[val]</td>
<td>Echo ON</td>
<td>OFF</td>
<td>[0-1]</td>
<td>0</td>
</tr>
<tr>
<td>L[val]</td>
<td>Monitor Speaker Loudness</td>
<td>[0-3]</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>M[val]</td>
<td>Monitor Speaker Mode</td>
<td>[0-1]</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>P</td>
<td>Select Pulse Dialing</td>
<td>No value</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>Q[val]</td>
<td>Result Code Suppression</td>
<td>[0-1]</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>T</td>
<td>Select Tone Dialing</td>
<td>No value</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>V[val]</td>
<td>DCE Response Format</td>
<td>[0-1]</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>Z[val]</td>
<td>Reset Default Configuration</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>&amp;C[val]</td>
<td>DCE RLSD (DCD) Behavior</td>
<td>[0-2]</td>
<td>0</td>
<td>1</td>
</tr>
<tr>
<td>&amp;D[value]</td>
<td>DTE DTR Behavior Note: The value 1 is not supported.</td>
<td>[0, 2]</td>
<td>0</td>
<td>2</td>
</tr>
<tr>
<td>&amp;F[val]</td>
<td>Set to QUALCOMM-Defined Default Configuration</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>A</td>
<td>Repeat Last Command</td>
<td>No value</td>
<td>X</td>
<td>X</td>
</tr>
</tbody>
</table>
## Table 2. Supported AT Commands

<table>
<thead>
<tr>
<th>AT Command and Syntax</th>
<th>AT Command Description (brief)</th>
<th>Value Range</th>
<th>Default If No Value Is Defined</th>
<th>Default Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>D&lt;dial str&gt;</td>
<td>Dial</td>
<td>#777</td>
<td>NA</td>
<td>NA</td>
</tr>
<tr>
<td>H&lt;val&gt;</td>
<td>Hook Control</td>
<td>0</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>O&lt;val&gt;</td>
<td>Return to Online State</td>
<td>0</td>
<td>X</td>
<td>X</td>
</tr>
<tr>
<td>S0&lt;val&gt;?</td>
<td>Automatic Answer</td>
<td>0</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>S3&lt;val&gt;?</td>
<td>Command Line Termination Character</td>
<td>[0-127]</td>
<td>13</td>
<td>13</td>
</tr>
<tr>
<td>S4&lt;val&gt;?</td>
<td>Response Format Character</td>
<td>[0-127]</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>S5&lt;val&gt;?</td>
<td>Command Edit Character</td>
<td>[0-127]</td>
<td>8</td>
<td>8</td>
</tr>
<tr>
<td>S7&lt;val&gt;?</td>
<td>Auto Retry Timeout in seconds</td>
<td>[0-255]</td>
<td>50</td>
<td>50</td>
</tr>
<tr>
<td>S777&lt;val&gt;?</td>
<td>Silent Retry Timeout (QUALCOMM specific command)</td>
<td>[0-255]</td>
<td>150</td>
<td>150</td>
</tr>
<tr>
<td>+ICF{&lt;format&gt;,&lt;parity&gt;?}=?</td>
<td>Character Framing Settings</td>
<td>(3-3), (0-3)</td>
<td>3.3</td>
<td>3.3</td>
</tr>
<tr>
<td>+IFC&lt;tx_ctl&gt;?</td>
<td>Local Flow Control Settings</td>
<td>(0-2), (0,2)</td>
<td>2.2</td>
<td>2.2</td>
</tr>
<tr>
<td>+IPR&lt;baud&gt;?</td>
<td>Rm Interface Baud Rate Setting</td>
<td>9600, 19200, 38400, 57600, 115200</td>
<td>9600</td>
<td>The power-on default baud rate is set through the phone's user interface (menu) &lt;4-&gt; &lt;5&gt;.</td>
</tr>
<tr>
<td>+CRM&lt;prot&gt;?</td>
<td>Rm Interface Protocol Setting</td>
<td>1-1</td>
<td>1</td>
<td>1</td>
</tr>
</tbody>
</table>
Index

A
accessories 4, 81
account information 33
adapters
  25-pin to 9-pin 4, 43, 44, 81
  null modem 4, 55, 81
addresses 22, 38, 52, 60, 67
Admin rights 7
advanced connection settings, Windows 13
antenna
  extending 6, 45, 57, 66, 83
  positioning 2
Apple computers 43
AT commands 58, 73, 85, 86
  list of supported 87

B
battery
  laptop 84
  phone 2, 83
baud rate 12, 27, 50, 58, 68, 72, 84,
  85, 86
  changing on phone 12, 27

C
cables 4, 5, 43, 55, 65, 79, 81
car kit 2, 3, 79, 82
Challenge Handshake Authentication Protocol 86
CHAP 86
  Name 68
chat script 67, 68
COM port 6, 40, 66, 80, 84
  conflict 85
Windows 10, 12
Windows 2000 26, 27
counters
  locking up 85
  Macintosh 43
  packet-data compatible 3
  positioning 3
UNIX 65
Windows 5
connecting
  car kit 79
  from Linux 77
  from Macintosh 53
  from Palm 61
  from Solaris 69
  from Windows 40
  Macintosh to phone 44
  Palm handheld to phone 56
  UNIX computer to phone 66
  Windows PC to phone 6
connection
  configuring for Windows 13
  configuring for Windows 2000 28
  configuring PPP 72
  new for Dial-Up Networking 15
  setting up for Palm 59
country code 19

D
data bits 13, 29
data cable 4, 5, 43, 44, 55, 56, 65,
  66, 81
Data Circuit-Terminating Equipment 87
Data Terminal Equipment 87
DCE 87
dial properties 23
Dial-Up Networking 15
  installing 15
  Windows 2000 31
DIN-8 43, 44, 81
disconnecting
  Linux 77
  Macintosh 54
  Palm 63
  Solaris 70
  Windows 41
DNS addresses 22, 38, 52, 60, 68,
  75
domain
  name 39, 52, 68, 75
  suffix 39
Domain Name Service
  Linux 75
  UNIX 68
drivers 8, 24
DTE 87
EIA-232 Signal 82
EIA-574 82
e-mail 1, 41, 54, 63
Eudora 1, 41, 54
extension cable 4, 81

flow control 13, 18
FTP 1, 41, 54

Gateway 2, 4, 12, 27
GEM 80, 82
Globalstar
  Electronic Module 80, 82
  packet data service
    defined 1
    overview 1
  requirements 2
  Satellite Antenna 6, 45, 57, 66, 83
  Satellite Communications
    System 1, 2
  signal 83, 84
GSP-1600 Tri-Mode Phone, see
QUALCOMM Globalstar GSP-1600 Tri-Mode Phone

Hardware (RTS/CTS) 13, 18
hardware components
  car kit 79
  Macintosh 43
  Palm 55
  UNIX 65
  Windows 5, 55
  hardware failure 84
  Hayes modem 67, 87
  host icon 69
HotSync
  cable 4, 55, 56, 81
  Manager 40, 53, 84, 85

IBM-compatible PCs 3, 4
Idle timeout 60
Ignore Dial Tone 50
initialization string 73, 86
interface 2, 81
Internet 1
  applications 84
  mail account 35
  protocol 36
  Service Provider, see ISP
  Windows 2000 connection 32
IP address 22, 37, 60, 67, 68
IP Header Compression 22
IP network protocol 41, 54, 63
IRQs 85
ISP 1, 4, 22, 38, 40, 52, 54, 62, 70, 75, 77, 84

kits
  car kit 2, 79, 82
  packet data 2, 4, 5, 41, 46, 54, 55, 65

LAN 32
line speed, PPP connection 72
Linux
  computers 70
  disconnecting 77
  making connections 77
  Red Hat 65
  LinuxConf suite 70
  Login name 72
Macintosh 43
  configuring 46
  disconnecting 54
  making connections 53
  modem cable 43, 44, 81
  pinouts 82
  Remote Access 46
  troubleshooting 85
mail account 35
  masks 52
  maximum speed 17, 84
  modem 12, 27
Microsoft Internet Explorer 1, 41
modem
  19200 bps 25
  33600 bps 10
  adapter 81
  cable 81
  for Palm 57
  hardware failure 84
  initialization string 73, 86
  port 50
  port conflicts, Macintosh 53
  port conflicts, Windows NT 10
Index-3

properties 11
script, Macintosh 46
setting up driver 8, 24
setting up for Linux 70
setting up for Windows 8
mouse 85

N
name server
  Linux 75
  Solaris 68
Netconf 70
Netscape Navigator 1, 41, 54
  network
    connection, Palm 59
    protocols, Windows 21
    provider 1, 4
No dial tone 84
null modem adapter 4, 55, 56, 81

O
over-the-air data rates 1

P
packet data connections
  for Linux 77
  for Macintosh 53
  for Palm 61
  for Solaris 69
  for Windows 40
packet data service, see Globalstar
packet data service

  Palm 55
    browser 63
    cable 81
    disconnecting 63
    handheld organizers 55
    making connections 61
    models 55
    operating system 85
    OS 55
    troubleshooting 85
  PalmPilot 55
  PAP
    authentication 72
    Id 67
    parity 13, 29
    password 33, 40, 53, 59, 72, 86
    pdQsuite 63
    phone
      connecting to Macintosh 44
      connecting to Palm 56

connecting to UNIX computer 66
connecting to Windows PC 6
GSP-1600, see QUALCOMM
Globalstar GSP-1600
  Tri-Mode Phone
  number, see telephone number
tips for using 2
pinouts, Macintosh 82
Point-to-Point Protocol 7, 49, 52, 60
positioning computers, for packet
data service 3
PPP 21, 49, 60
  connection for Linux 70
daemon 86
  see also Point-to-Point Protocol
  Solaris client 67
pppinit 69
ppptool 69
problems 83
protocol 36, 49

Q
QUALCOMM
  Globalstar GSP-1600 Tri-Mode
    Phone 1, 5, 43, 55, 65
  Globalstar Hands-Free Car Kit
    2, 3, 79, 82
  Globalstar Packet Data Kit 2, 4,
    5, 41, 46, 54, 55, 65, 81
  Globalstar Phone Modem 46, 50,
    85
  serial data cable 5, 43, 44, 55, 65,
    66, 81
Query DNS 60

R
Remote
  Access, Macintosh 46
  server 69
router 2
RS-232 6, 66, 80

S
satellite 2
  antenna 83
  unobstructed access 3
serial
  data cable, see QUALCOMM
  serial data cable 4
  port conflicts, Windows 40
service provider 4
signal 84, 85
obtaining 6, 45, 57, 67, 83
software compression 21
Solaris 65
disconnecting 70
making connections 69
Solstice PPP 67
speed
Palm modem 58
see also maximum speed, baud rate
standard modem 10
Windows 2000 25
stop bits 13, 29
string, Palm modem 58

T
TCP/IP 1, 21, 36, 49, 50, 52
Windows settings 22
telephone number 19, 33, 48, 60, 67, 73, 83
telnet 1, 41, 54
TIA/EIA-574 DTE serial interface 2, 81
tone dialing 23, 67
touch command 68
TouchTone 58
Tri-Mode phone, see QUALCOMM
Globalstar GSP-1600 Tri-Mode Phone
troubleshooting 83

U
Universal Serial Bus 4, 81
UNIX computers 65
troubleshooting 86
USB 4, 43, 44, 81
user name 33, 40, 59
usernetct command 77
using
computers 3
Globalstar packet data service 1
Globalstar phone 2

V
vehicles 2, 3, 79

W
Windows
also see Windows 2000,
Windows NT
configuration instructions 8
connecting components 5
Dial-Up Networking 15
disconnecting 41
making packet data connection 40
setting up modem driver 8
TCP/IP settings 22
troubleshooting 84
Windows 2000
Admin rights 7
configuration instructions 24
configuring networking
properties 36
configuring PC for 7
driver speeds 25
Internet connection 32
making packet data connection 40
naming dial-up connection 34
setting up a new connection 30
setting up modem driver 24
Windows NT
Admin rights 7
configuration instructions 8
configuring PC for 7
one modem per port 10
wireless modem 1, 7, 59, 87